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SOFTWARE GUIDE INTRODUCTION 

The DynaPulse 5000A is Pulse Metric’s ambulatory version of a non-invasive blood pressure system 
known as Pulse Dynamics. It is based on a unique oscillometric technique that allows you to obtain 
clinically accurate blood pressure data quickly and easily.  The system comes with a hardware monitor 
and support software.  The DynaPulse 5000A Hardware User’s Guide describes the hardware monitor 
and its use. The DynaPulse 5000A Software User’s Guide explains how to download data from the 
hardware monitor and convert the measurements into easy-to-use graphs and reports that allow for 
simple, yet accurate analysis.  

If you are familiar with the standard features of Windows software, you will find the DynaPulse 
software easy to use. The information required to install and run the software is provided in this manual.

The DynaPulse customer support team is committed to ensuring your continued satisfaction.  You are 
welcome to call us with questions or comments at 760-842-8278.

Indicator Used in this Manual

to call your attention to an important feature

Note: The DynaPulse program provides hotkeys to quickly access the main menu items. If an underlined 
letter is part of the program menu item name, you can activate this item by holding down the <Alt> 
button on your keyboard and typing the identified letter key.
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 FACTS ABOUT HYPERTENSION

Hypertension is elevated blood pressure that persistently exceeds a safety threshold.  The Sixth Report 
of the Joint National Committee on Prevention, Detection, Evaluation, and Treatment of High Blood 
Pressure estimates that the blood pressure of 50 million Americans consistently equals or exceeds 
140/90 mmHg.  Hypertension increases the risk of developing cardiovascular diseases and stroke, and 
about three quarters of those who have hypertension are not controlling it well.  

HOW IS BLOOD PRESSURE MEASURED?

There are many ways to measure blood pressure.  To achieve the most accurate measurement, a doctor 
must insert an intra-arterial catheter. 

Less invasive indirect methods were devised to allow safe, quick measurements.  Still, the accuracy of 
non-invasive methods is judged against the standard of catheter-based measurements.

The auscultatory method is now the most common method used to measure blood pressure.  After 
inflating a cuff around the patient's arm, the health practitioner places a stethoscope against the arm and, 
as the cuff is deflated, listens for Korotkoff sounds to determine systolic and diastolic pressure.  

One benefit of this method is the direct relationship of the technique to the blood flow.  Blood pressure 
variations in the artery create the Korotkoff sounds. Many other techniques obtain blood pressure by 
mathematical calculations that are not directly observable.

The auscultatory method does have several drawbacks. Extensive training is required to ensure 
accuracy.  The human ear may effectively respond to frequencies between 20 and 20,000 Hz, but the ear 
hears best between the range of 200 and 4000 Hz.  The Korotkoff sounds heard through an acoustic 
stethoscope range from 18 to 26 Hz at systolic cuff pressures and 40 to 60 Hz at diastolic pressures.  
These frequencies are not in the range at which humans are most sensitive.  Measurements taken by 
different people on the same patient can vary due to differences in hearing ability, even if the 
measurements are taken at the same time! 

This method also encountered difficulty when patient conditions, such as hypotension, mute or dampen 
the Korotkoff sounds.  

Other automated blood pressure monitors are designed to solve the hearing variability problem by using 
microphones with sound-based algorithms to estimate systolic and diastolic blood pressure.  
Unfortunately, by removing the human element, these devices lose the advantage of professional 
validation. They also have problems estimating blood pressure in patients with muted Korotkoff sounds. 

These difficulties prompted the development of the Oscillometric technique.  Instead of listening for 
characteristic sounds, the Oscillometric technique uses a cuff and a pressure sensor. These devices 
estimate blood pressure by examining the pressures generated by the cuff and the arterial pulsation.  The 
estimations are based on large amounts of data and are usually accurate, but they are still estimations.
The algorithms are not based on arterial flow or pressure.  These devices determine mean arterial 
pressure, then estimate systolic and diastolic pressures.

The Next Step
What is needed is a technology that combines the best of the auscultatory and oscillometric techniques.  

 A technique that, like the auscultatory method, is based on blood flow properties.  

 A technique that also offers validation capabilities, like the manual auscultatory method.  
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 A technique that, like the oscillometric method, works on a broad range of patients, including 
those whose cardiovascular problems may make their blood pressure difficult to measure.  

Above all, the technique must be accurate.  

The DynaPulse blood pressure monitor meets all of these criteria. Pulse Dynamics, the patented 
technology used with the DynaPulse 5000A, also measures the pressures generated by the cuff and the 
arterial pulsation. However, it is the only oscillometric method to measure blood pressure based on 
physical phenomena, much like the auscultatory method.  Instead of estimating blood pressure, Pulse 
Dynamics uses pattern recognition to determine systolic, diastolic, and mean arterial pressure, each of 
which is measured independently from the Pulse Dynamic pressure waveform. This pattern recognition 
technique is possible due to the effect that blood flow has on the measured pressures at the brachial 
artery.  Pulse Dynamics measurements have been found to agree extremely well with catheter-based 
measurements.

Accuracy of the 5000A Systems
To obtain FDA 510K registration for the DynaPulse, Pulse Metric (PMI) validated Pulse Dynamics 
accuracy relative to both auscultatory and invasive catheter measurements. 

A 132-patient study compared the monitor to the auscul-tatory method, in accordance with Association 
for the Advancement of Medical Instrumentation (AAMI) 10-1987 guidelines.  The DynaPulse achieved 
correlations of 0.96 and 0.89 for systolic and diastolic pressures, respectively.  When the DynaPulse was 
compared to invasive, intra-arterial measurements (a 36-subject study), correlations of 0.94, 0.91, and 
0.95 were found for systolic, diastolic, and mean arterial pressures, respectively.

Summaries of these two validation studies are presented on the following pages.

Interpreting the Results
In all cases, the graphs compare Pulse Dynamics to either invasive measurements (using a catheter) or 
auscultatory measurements.  
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Standard Error of Estimation 5 5

Correlation Coefficient 0.96 0.89

Experimental Conditions:
1. Total Subjects: 132 3. Heart Rate Range: 45-115 BPM
2. Age Groups: (11-24) = 28 (25-44) = 38 4. Data represents a three measurement

(45-64) = 28 (65-85) = 38     average.
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comparison.  A coefficient of 1 corresponds to a perfect correlation.  As a general rule, coefficients 
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above 0.80 are considered good correlations.  The line on each graph has been fitted to the 

data.

Pulse Dynamics vs. Intra-Arterial Catheterization (UCSD Medical Center)

Pulse Dynamics vs. Intra-Arterial Catheterization Summary

Systolic Diastolic Mean Arterial

          Mean Difference (Cath. - PD) -2 -4 -1
          Standard Deviation 9 6 5
          Standard Error of Estimation 9 6 5
          Correlation Coefficient 0.94 0.91 0.95

Experimental Conditions:
1. Total Subjects: 36 3.  Data represents a three measurement
2.  Invasive Pressure Site: Descending Thoracic Aorta      average.
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Copies of abstracts and other clinical research information may be obtained by contacting Pulse Metric 
for a copy of the Pulse Dynamic Clinical Research Guide.
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I. INSTALLATION

System Requirements

Installing the DynaPulse 5000A Software

Setting Up the DynaPulse 5000A Software

SYSTEM REQUIREMENTS

To install the DynaPulse 5000A, you will need the following equipment:

 IBM PC or compatible with at lease 486x/66 processor, 32 MB RAM, a hard drive, and a CD 
ROM drive.

 Windows 98SE/ME/NT/2000/XP

 One USB port

INSTALLING THE DYNAPULSE 5000A HARDWARE 

See the DynaPulse 5000A Hardware Guide

IMPORTANT: PRROCEDURES ON HOW TO SETUP YOUR COMPUTER FOR USB 
COMMUNICATION CAN BE FOUND ON PAGE 63 OF THE SOFTWARE GUIDE. THIS 
MUST BE DONE BEFORE USING YOUR DYNAPULSE.

INSTALL THE DYNAPULSE 5000A SOFTWARE 

If you have a previous version of DynaPulse 5000A installed on your hard disk and want to maintain the 
same measurement files created with that version, enter the drive and directory path where the original 
program files are stored when the installation utility asks for the installation path. Do not delete the 
previous files.

In Windows, click on Start, then Run, and type in the letter used for your CD ROM drive follow by 
:\setup.

Start the Software Program
Once the software is installed, you will see 
the DynaPulse 5000A icon on the desktop. 
To start the DynaPulse 5000A, double-click 
on that icon

In addition to the icon on the main window, which you can always use to start the program, the 
installation program places four function links for the DynaPulse 5000A under
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Programs, which you can 
access via the Windows Start
button, Programs, DynaPulse
and click on the DynaPulse 
5000A icon.

The first screen will be the Institution Information dialog. 

Enter the requested information and click on OK. This will take you to the Patient List that displays the 
patient names and is likely to be empty. The dialog appears automatically only on initial use. If you need 
to change the information on this dialog, you can access it from the Default menu.

Before you enter any patient information you need to configure the Communication Port for the 
DynaPulse.

SETTING UP THE SOFTWARE

Communication Ports
At this time you need to attach your DP5000A monitor, with the 4 AA batteries installed, to your 
computer. 

1. Plug the large end of the provided cable into your PC’s USB port and the smaller end into the 
DP5000A monitor. 

2. Make sure that the DP5000A monitor is switched ON and in the ready mode and is connected to the 
computer via the supplied USB cable to an open USB port.

1. From the Port menu, select Com 
Check. This will display the message 
shown below.

2. Select OK.

Com Check will automatically detect and record the communications port used by the DynaPulse 
5000A unit and display the message shown below.
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4. Select OK to set the Port setting automatically. The Check Box will default to the port where the 
Com Check program finds the DP5000A.

Note: Programs that interface with the computer through a COM port, such as Personal Digital 
Assistants, will lock out any other devices from using this port. You will need to turn off this feature of 
the PDA software to communicate with the DP5000A.

The program will return you to the Patient List. 

Activate Toolbar and Status Bar

You can show or hide the toolbar and 
status bar through the View menu at 
any time by checking either Toolbar or 
Status Bar.

  
The DynaPulse 5000A program has a menu at the top of the screen and a toolbar consisting of clickable 
shortcut buttons below the menu bar. The menu options found in the File, Window, and Help menus 
work the same as in other Windows programs. Other menu options are DynaPulse program functions. 
The content of these menus will change depending on the screen is open when you access the menu. 
You can select many of the menu options by pressing the <Alt> key and typing the underlined letter in 
the item name. For example, typing <Alt> and the x key would select the Exit command, quitting the 
DynaPulse program. 
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GETTING STARTED 

PATIENT LIST 

The Patient List is the first screen to appear when you open the DynaPulse 5000A program. It normally 
remains open in the background when other screens are open, but you can use the Window menu 
functions Tile (to view the list while other screens are open) or Arrange Icons (to reduce it to an icon at 
the bottom of the screen).    

To make changes to the Patient List, highlight the name to be changed, then use the Patient menu 
options Edit and Delete, or the Data menu option Data Transfer. When a name is highlighted, you can 
also access the View menu options Trend List and Personal Info.

If the list is large, you can either scroll the patient list to find a particular patient or use the Find function 
on the Patient menu to open a dialog where you enter the patient’s name to run a search.  

Sort: Patient List

In the Patient List, you can sort the patient data in either ascending or descending order by name, ID or 
file location. For example, clicking on the ID column heading will automatically sort the list by ID in 
numerical order followed by alphabetical order. Clicking the ID heading a second time will resort the 
list in reverse order. 

ADD A NEW PATIENT

The best way to get started is to add a new patient (you) and take a few measurements.  As you use the 
DynaPulse 5000A unit repeatedly, you will find that efficient operation quickly becomes second nature.

1. Select Add from the Patient menu.  You will be prompted to enter a name and identification value 
(ID).  Use the Tab button to move between the fields. Using medical record or social security 
numbers for ID is often helpful. 
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2. File Location displays the default path to the location where the patient's data will be stored.  To 
change the path if it is missing or incorrect, use the button marked with three dots to open the Select 
a Directory dialog.

To use the Select a Directory dialog, select the drive.  Click on the highest-level directory that is in 
the correct path to display all of the subdirectories, and choose the subdirectory, etc.

Note: Do not store measurement information in the root directory (C:\). Use the default directory 
(c:\Dp5win\Win32), or an alternative directory such as c:\DpDATA.

The drive or directory can be on either a hard disk drive (C:) or a CD ROM (Y:).  If you will be 
selecting and sorting the Patient List by last name, type the patient name in a "last name first, first 
name last" format.

3. Select OK. Once you have added a patient, the name will appear on a patient list. Below is an 
example of what you should see after clicking OK. Your patient is now registered. 

Page 10 explains the Patient List in more detail. If you 

double click on the name, a "No data available" box should
appear like the 
one to the right. 
You are now 
ready to take 
measurements 
and store them 
in your own 
patient file.

TAKING MEASUREMENTS

There are two modes for taking measurements with the DynaPulse 5000A:  manual and ambulatory.  
While the DynaPulse 5000A Hardware Guide describes how to use the monitor for both types of 
measurement, the ambulatory method also requires software setup that is described below. 
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IMPORTANT:  Before taking new measurements:

The DP5000A’s internal memory can store up to 100 measurements for a single patient. Before you can 
use the DP5000A for a different patient or for the same patient taking more than 100 measurements, the 
data in the DP5000A’s memory must be transferred to a host computer so that the DP5000A’s memory 
can be cleared and reused. See pages 13 through 13 for information about the transfer and clear memory 
functions.

Setup for Ambulatory Blood Pressure Recording 
To ensure correct setup and operation of the DP5000A, check the following:

1. Simply plug the small end of the USB cable into

the DP-5000A monitor and the larger end into 

the USB port of your computer.

2. The DP5000A monitor must be switched on and in “Ready” mode.

3. The correct patient name and ID must be highlighted.

4. From the Data menu, select Enable Amb. 

5. Disconnect the cable from the DP5000A unit to the computer and allow the unit to operate on 
battery power. See the DynaPulse 5000A Hardware Guide for details. 

Disable Ambulatory Mode:

Use this setting for downloading at the end of an ambulatory session or if the ambulatory monitoring 
needs to be ended prematurely. This does not transfer or clear the data or ID, but the ambulatory mode 
should be disabled before a data transfer.

To disable ambulatory mode, select Disable Amb from the Data menu.

Conventional Blood Pressure Recording
See the DynaPulse 5000A Hardware Guide

Guidelines for Blood Pressure Measurement

Position 

Ambulatory measurement is not intended to imply that the user should be in motion during a reading.  
Gravity and body position both affect blood pressure.  Standard measurement protocols suggest that: 

 The patient should be seated comfortably and relaxed for 5-10 minutes before taking measurements. 
The idea is to get a measurement that is most representative of the patient’s "resting" blood pressure.  
By sitting, the patient is more relaxed, and movement can be kept to a minimum.  

 Both legs should be flat on the floor with the legs uncrossed. 

 The upper arm should be resting at the level of the heart.  Keeping the arm at heart level minimizes 
the gravitational effect on blood pressure as the blood travels from the heart to the arm.  

Measurements may also be taken in the standing position with the arm elevated and rested at heart level.

Use the Correct Blood Pressure Cuff

Cuffs come in three sizes:  Small, standard, and large.  Before taking a measurement, determine the 
correct cuff size for the patient.  American Heart Association (AHA) guidelines recommend that the 
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rubber bladder inside the cuff should encircle 80% of the arm in adults and 100% of the arm in children 
less than 13 years of age.

Correct Cuff for Various Arm Circumferences

(Measured in Inches at the Bicep)

Small cuff for children 
and small adults

Standard cuff for 
adults

Large cuff for adults

7” to 10.5” 10” to 13.75” 13” to 18.5”

If you cannot decide between the cuffs, use the standard cuff. 

Transfer Measurement Data to Computer
After taking measurements, the data in the DP5000A’s memory must be transferred to a host computer 
so that the DP5000A’s memory can be cleared and reused.  Once again:

1. There must be a proper cable connection between
DP5000A and the computer USB port.

2. The DP monitor must be on and in “Ready” mode.

3. The correct patient name and ID must be highlighted.

From the Data menu, select Disable Amb.

Once the ambulatory mode on the DP-
5000A has been disabled, select Data 
Transfer from the Data men.  The Data 
Transfer command to transfer the 
measurement data from the DP5000A 
device. The session data will be saved as a trend of measurements to the selected patient data file along 
with the patient ID.

A message will appear briefly during the transfer to display the current status of the transfer. When the 
transfer is complete, you will be prompted to add a comment. 

Clear Memory
This command, found in the Data menu when the Patient List is displayed, will delete all measurement 
data stored in the DP5000A device memory. Measurements deleted from the device cannot be restored. 
Data on the computer hard drive is not affected. If you use the Clear Memory function without first 
transferring the measurements, the data will be lost.

If you transfer data to the host computer without clearing the DP5000A memory, some of the files in the 
host computer will duplicate the unpurged files in the DP5000A memory.  However, the next time you 
transfer data to the same directory, the system will not allow you to download the duplicate copies. 

Clearing memory is necessary to free up space for a new batch of measurements. It is recommended that 
the device memory be cleared after every data transfer to free up space for the next set of measurements. 
The only reason the DP5000A does not clear its memory automatically after a download is to allow 
those who need to do so to download the same data to more than one location.
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From the Data menu, select Clear Memory. You will be prompted twice to confirm your decision. 

CAUTION: do not clear the memory until all important data have been transferred. This function also 
clears the patient ID from the monitor.
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II. BASIC OPERATION

Measurement Result

Trending and Analysis

Managing the Displays

MEASUREMENT RESULT

Blood Pressure 
The DynaPulse 5000A can estimate either systolic (SBP) or diastolic (DBP) blood pressure values from 
accurate measurements of Mean Blood Pressure (MAP) and either SBP or DBP. 

The View menu lists the major patient 
data screens: Trend Graph, Trend List, 
Measurement List, and Personal Info. 
The Personal Info screen is used to 
note a patient's vital statistics and 
contact information. The screens listed 
on the View menu will vary depending 

on which window is open when you access the menu. The menu above is accessed from the Trend List.

The toolbar and status bar toggle options are always present in the View menu. 

You can also access the Trend List by double clicking on a name displayed on the Patient list. The Trend 
List displays the measurement trends that a selected patient has recorded and transferred with the 
DP5000A.  For further details on a selected group of measurements when the Trend List is active, the 
available View menu options include the Trend Graph and the Measurement List.  

View: Measurement List 
The Measurement List is a convenient summary displaying for a selected patient the systolic, diastolic, 
MAP (mean arterial pressure), and HR (heart rate) data as well as any comments appended to the 
measurements. Unlike the Trend Graph, the Measurement List displays the trend data as a list, rather 
than a graphical plot. 
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Blood pressures are listed as a systolic (when the heart beats) over diastolic (rest period between beats) 
reading, for example: 120/80 mmHg. Mean arterial pressure is the clinically defined "average" of your 
blood pressure, taking into consideration both systolic and diastolic pressures. 

You can add a comment or mask/unmask any data record in the Measurement List. (You can also mask 
measurements in the Trend Graph.) Masking a measurement makes that measurement invalid, so it is 
not counted when analyzing valid data. Masked data are labeled with an "M" under Status, while 
erroneous data (when the DP5000A could not detect a proper waveform) are labeled with an "Err." 
Since the erroneous measurements have no valid blood pressure data, the blood pressure and heart rate 
values display as zeros. 

Sorting the Measurement List

By default, the valid measurements start out listed by when the measurement was taken. You can re-sort 
the measure-ments in ascending or descending order by clicking on the column header. The sortable 
headings in the Measurement List include: date/time; status, systolic, diastolic, and mean arterial 
pressures; and heart rate. For example, clicking on MAP sorts the data in either ascending or descending 
order according to mean arterial pressure. Clicking on the Status heading will move masked and error 
(Err) measurements to either the top or bottom of the measurement list. Clicking on Status after clicking 
on MAP will move the masks and Err measurements to the top or bottom of the list, but the 
measurements themselves will remain sorted with respect to MAP.

TRENDING AND ANALYSIS 

Disease management often requires long-term patient monitoring. With hypertension, this often requires 
blood pressure information to be accumulated and analyzed over the remaining lifetime of a patient. 
Isolated measurements have a limited benefit, but a series of measurements over time provides a 
representative average of your patient's blood pressure. Measurements taken during each DP5000A 
session can be plotted and analyzed to search for trends during the measurement time period.

View: Trend List 
The Trend List lists all measurements 
taken for a specific patient. You can 
access the Trend List by double clicking 
a name on the Patient List or by 
selecting Trend List from the View 
menu when a patient data screen is open. 

The DynaPulse program allows you to sort most listed data by column topic. You can sort data in the 
Trend List by clicking on a column heading, such as trend number, number of measurements, start 
date/time, or end date/time. As with the Patient List, you can sort data in ascending or descending 
alphanumeric order in each field. With the date/time columns, they will sort by earliest or latest time. 

The comment box allows you to type in messages.
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View: Trend Graph 
DynaPulse trending allows you to plot a patient's blood pressure information over time in an attractive, 
graphical format.  Line graphs of the blood pressure and pulse measurements show at a glance the 
patient's response to the treatment regimen. Your DynaPulse 5000A allows you to track a number of 
patients in this manner.  

The Trend Graph displays a blood pressure chart (in mmHg vs. time), a pulse pressure chart, a heart rate 
chart (in BPM, or beats per minute, vs. time) and a waveform of the currently selected measurement. 
The selected measurement is indicated by a vertical dotted line on the waveform. The value labels show 
blood pressures, date/time, and heart rate for that reading in white boxes. 

By default, systolic values are shown in red, MAP values in yellow, diastolic in blue and HR in green. 
Night time data is shown as a dark gray region in each chart. (The time period can be adjusted in the 
analysis setup.)

To access the Trend Graph, double 
click on a patient name on the Trend 
List.  You can also select the Trend 
Graph feature from the View menu 
when a trend is selected on the Trend 
List.

To browse through the data and see corresponding waveforms for any measurement, just click the point 
you want on BP chart or HR chart.

Use the movement buttons on the toolbar  or the arrow keys on your keyboard, to move the 
dotted line.

Plot Style - Line Plot and Area Plot 
When the Trend Graph or a linear chart is 
displayed, the Style menu gives options to 
change the type and format of the 
displayed chart. 

Area Plot: By checking this, the DynaPulse software fills the area under the trend curve by its 
respective color (the systolic trend plot will be colored red, diastolic blue, MAP yellow, and heart rate 
green). Area plot is the default plot style of all analysis graphs, including the Trend Graph. 
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Line Plot: By checking this, the DynaPulse software plots the chart with measurement points connected 
by lines (Note: when you select one of the plot style options, the other is automatically disabled.) 

Hide MAP: Selecting the Hide MAP option will hide the MAP values and threshold curve. Deselecting 
the option will toggle back the MAP values. 

Hide Label: Selecting the Hide Label option will hide the labels marking the current values in the Trend 
Graph (this style option is not available with the analysis charts, which do not have labels). Toggle back 
and forth between hiding and revealing the labels by checking or unchecking this option. 

Masking Problem Data
Using the waveform you can validate each measurement. If you have a measurement that should not be 
included in the statistical analysis, click on Mask, and it will no longer appear on the screen or in the 
statistics. Clicking on the mask field again will restore the data. A masked measurement will be overlooked 
during data analysis or printing reports of valid data. Unchecking the box will unmask the measurement. 
(Measurements can also be masked in the Measurement List.) Erroneous measurements, unlike masked 
measurements, are automatically labeled and overlooked because the DP5000A device had problems during 
measurement.

Measurements should not be masked without due cause.  Masking decreases the amount of data 
available for analysis. A pressure waveform does not have to be perfect to yield clinically sound data.  
To ensure that all the data is evaluated uniformly, we suggest that you create your own criteria for 
masking a measurement.  

To view the waveform in closer detail, use the mouse to double click on an area within the waveform 
displayed on the Trend Graph. This will change to the waveform screen where you can view the waveform 
in greater detail.

Arterial Waveform 
The arterial waveform represents the pressure signal produced by the interaction between the restrictive 
cuff and the pressures generated by the cardiac cycle.  A pressure sensor in the DynaPulse unit measures 
this signal at the brachial artery.      

As you view a patient's Trend Graph, you may click on the waveform chart at the bottom of the dialog to 
enlarge that area of the waveform.

The lower portion of the screen displays entire waveform during the measurement period. The Systolic, 
Diastolic, MAP (mean arterial pressure), and HR (heart rate, or Pulse) values of this measurement are 
shown in the upper right table. There are two scales for the arterial waveform.  The bottom scale is cuff 
pressure in mmHg. The upper scale measures time in seconds.  The amplitude (height of each individual 
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spike or pulse) indicates the arterial pressure of a particular pulse relative to the cuff pressure and blood 
flow.  

The current time interval in the upper expanded view is indicated by the vertical dotted line on the lower 
waveform. To get a clearer view of any portion of the waveform during a two-second interval, click on 
that point in the lower waveform, and the upper view will expand that area. The upper chart is called the 
Arterial Pulse Display. It shows a magnified set of heartbeats marked by the cursor in the waveform 
below.  As you move the cursor from one heartbeat to the next, the Arterial Pulse Display changes to 
show the heartbeat to the right of the cursor position.

Using the arrow keys on the toolbar  or the arrow keys on the keyboard will move the 
cursor to select a different waveform pulse. 

Understanding the Waveform

Starting from the left, blood flow is restricted by the cuff. As cuff pressure falls, the blood’s counter 
pressure is detected at the edge of the cuff and displayed as a rise in amplitude. As the cuff pressure 
declines, renewed blood flow allows each pulse to strike the entire width of the cuff, causing the pulse 
amplitude to increase until it reaches its maximum height on the waveform.  Beyond that point the 
amplitude declines.   

Pressure icons (the three colored boxes located below the pressure waveform) indicate the points where 
the cuff pressure equaled the patient's systolic, mean, and diastolic blood pressures. The point where 
blood flow is initially detected is noted by the left-most box and referred to as systolic blood pressure 
(SPB). The period of maximum amplitude, noted by the middle pointer, is called mean arterial pressure 
(MAP). The third pointer indicates the diastolic blood pressure (DBP) point.  

Note that the systolic and diastolic points can also refer, respectively, to the top and bottom of the wave.     

The DynaPulse measurement process relies on pattern recognition to detect changes in the shape of the 
pressure wave as it moves from systolic to diastolic pressure.  It is not dependent on the pulse amplitude, 
or strength.

The Arterial Pulse Display 

The pressure wave shown in the arterial pulse display corresponds to the heartbeat marked by the cursor 
on the arterial waveform.  The pulse wave is displayed in units of mmHg and one-hundredths of a 
second.  You can identify the systolic (SBP) and diastolic (DBP) points of individual heartbeats, as well 
as specific cardiovascular events such as pressures corresponding to the opening and closing of the 
aortic valve.  This display is often used for educational purposes.

second intervals

Millimeters of 
Mercury 

(mmHg.)

ACCURACY VALIDATION AND IRREGULAR HEARTBEATS

The arterial pressure waveform can be used for validating measurement accuracy and detecting irregular 
heartbeats.  Features of the waveform that are used for accuracy validation are:
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 Waveform Quality

 Pressure Icon Position

Waveform Quality

Examine the characteristic shape of the arterial waveform.  

An ideal waveform has the following characteristics.

 The waveform is 20-30 seconds in length.

 The waveform is symmetrical and has a waxing and waning pattern.

 Pressure limits are set correctly

 No motion artifact is present

Any disruption of the pressure wave caused by irregular heartbeats or by patient movement (arm 
movement, talking, coughing, etc.) can potentially compromise the accuracy of the measurement.  These 
disruptions in the pressure wave are typically referred to as "artifact."

In a normal waveform display, the heartbeats will occur at regular intervals and will have uniform width 
and shape.  Poor quality measurements often have jagged and unevenly spaced heartbeats.  

Pressure Icon Position

The position of the pressure icons relative to the position of the artifact will indicate whether the 
measurement has been compromised.  If an irregularity in the pulse waveform occurs close to one of the 
blood pressure icons or if there is significant patient movement at one of the blood pressure indicators, 
you may have a poor quality measurement.

As you use the DynaPulse, you will notice that individual patients will display characteristic waveform 
patterns.  Some patients will have a shorter, fatter waveform, some a thinner, more elongated waveform.  
Some waveforms will have a high amplitude, some a low amplitude with differences in the air release 
time.  

Waveform patterns may vary due to various physiological differences, specifically in the composition of 
the patients' arm.  For example, an individual with a muscular arm has little in the way of fat tissue to 
impede the pressure signal acquired by the DynaPulse.  An obese arm has significant amounts of fat 
tissue, which will tend to damp the pressure signal.  These physiological differences will be reflected in 
the appearance of the pressure waveform.

Let us assume that you keep the air release time within the normal limits of 20-30 seconds, then 
measurements should be always obtainable; assuming no movement artifacts are introduced.  What 
happens if your measurements are taken with air release times outside this range?  Shorter air release 
times produce individual heartbeats that are spread farther apart.  With a longer release time, heartbeats 
will be close together.  This holds true for heart rate as well.  With a slow heart rate, the heartbeats will 
be spread farther apart.  With a fast heart rate, the heartbeats will be closer together. With practice, you 
can become familiar with how a good measurement should appear. 

You will discover how the differences in air release rate will cause differences in the appearance of the 
DynaPulse pressure waveform.  The following waveform examples illustrate how pressure waveforms 
might differ from one patient to the next. 
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In this example, blood pressure measurements were taken on the same individual.  Even with the blood 
pressures and heart rate being similar, the difference in air release time caused the waveforms to appear 
quite different.

MANAGING THE DISPLAYS

Cascade, Tile and Close All Windows
The DynaPulse 5000A allows you to display multiple measurements on the screen. This feature is useful 
if you wish to compare data from different measurements.

Features like the Cascade
and Tile options (accessed 
from the Window menu) 
help organize open 
windows. 

The Window menu also 
lists the open displays. 
Choosing any listed 
display brings that display 
to the foreground.

Selecting the Tile option produces a display as seen below.

Choosing the Cascade option causes each window to overlap so only title bars are visible. 
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Arrange Icons
You may also clean up the display screen and still have several measurements available for your review 
by using the Arrange Icons option from the Window menu. Any Measurement, Trend, Record Table, or 
Patient List may be minimized and arranged by selecting this feature.

Choosing the Close All option will clear off all measurement screens and reduce the Patient List and 
Trend windows (if open) to icons. The icons will indicate the time and date of the measurement 
associated with the icon.
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PRINTING

You can print any displayed graph or report by selecting Print from the File menu or by using the 
toolbar print icon. 

Use the standard Windows-type Print dialog to select the printer and the number of copies and range of 
pages.  Other print functions are described in the following chapter.
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III. ADVANCED OPERATIONS

Personal Information 

Statistical Analysis Setup

Statistical Analysis Graphic Displays 

Statistical Analysis Reports 

Data Export 

The Tool Window

PERSONAL INFORMATION

The Personal Info (Patient Record) dialog allows you to create, view or edit personal information for a 
selected patient. This dialog has sections for entering or viewing such information as physician 
information, phone numbers, street address, fax numbers, e-mail), medical institution, statistical 
information (birth date, height, weight, gender) and a brief medical history. Personal information for 
each patient can be printed in report form.

Use the following procedure to open and use the Personal information dialog for a patient.

1. On the Patient list, click on the 
patient’s name.  This will 
activate the Personal Info
option on the View menu.

2. Select Personal Info from the 
View menu. You may be asked 
to indicate whether you want to 
use default institution data.

If you click Yes, the 
DP5000A 
automatically fills in 
the institution fields 
with default data.

If you click No, the institution fields of the dialog will be empty when it opens. 
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3. There is no Save or OK button. Select Save from the File menu when you finish.  If you forget to do 
this, you will be prompted to save when you exit the dialog.

STATISTICAL ANALYSIS

Setup
The Analysis menu is available 
when you select a patient from the 
Patient List. The Setup dialog 
displays the measurement intervals 
and allows you to reset the day and 
night start times and the systolic and 
diastolic thresholds. A single down 
arrow (Start Time) opens a selection 
list. A double arrow allows you to  
Raise or lower the threshold values. 
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Start Time: Ambulatory measurements in a 24-hour period are divided into day and night periods. The 
selected time indicates the start of the period (the start of the day period will be the end of the night 
period).

Systolic and Diastolic Thresholds: The DynaPulse program will automatically count blood pressure 
readings higher than the threshold values you specify, and these measurements will be tallied in data 
reports and charts as percentages of the total number of measurements. Having the thresholds set too 
low or too high would not be useful in analysis. Both the systolic and diastolic thresholds are set to 
values suggested by JNC VI1 guidelines. High blood pressure is defined as pressure in excess of 
140/90mmHg, so the default setting for the daytime systolic threshold is 140mmHg, and since blood 
pressure are normally lower when a person is asleep, the default nighttime systolic threshold is 
120mmHg.  

Interval: The interval between measurements is displayed and cannot be changed from this dialog box. 
This is set within the DP5000A device itself at the start of each ambulatory session. 

Default Menu Setup
Before using the analysis tools, you should set the defaults for reports, analysis graphs, and printing.  Set 
these values from in the Default menu. 

Some of the default options 
can be changed at any time, 
but you must be at the 
patient list window level, 
and any changes made will 
not apply until new patient 
data is opened. While 
viewing open patient data,   
you cannot change default options for Pressure Unit and Histogram Bin Size. In order to change these 
options, you must close all patient data screens.

                                                
1  Joint National Committee on Prevention, Detection, Evaluation, and Treatment of High Blood Pressure. The sixth report of 

the Joint National Committee on Prevention, Detection, Evaluation, and Treatment of High Blood Pressure, November 
1997.
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Graphs… (Print Settings)
Selecting 
Graphs 
from the 
Default 
menu will 
bring up the 
Print 
Graphs 
window. 
Use the 
radio 
buttons to 
select or
deselect all graphs for printing, or use the checkboxes to select or deselect individual graphs to print. 
Each checkbox corresponds to a chart type located in the Analysis menu. Clicking the Ok button will 
not print the graphs, but actually set the default options for future printing, whether by direct print or 

with the toolbar print buttons (e.g., express print). 

Default Reports Print Settings 
The Default menu has options to change the report printing settings. The Print Reports window lists the 
different reports that can be printed through the File menu or with the toolbar print buttons.
Use the radio buttons 
to select or deselect all
reports for printing, 
and use the check 
boxes to select a single 
report. Clicking the 
Ok button will set the 
default settings and 
will not actually print 
reports. These default 
settings will show up 
the next time you print

reports and will also determine what will be express printed. 

Default: Export Settings 
Blood pressure data 
and analysis can be 
exported into a text 
(ASCII) file or 
similar file for use 
outside of the 
DynaPulse program. 
From the Default 
menu, select Export
to bring up the ASCII 
Output to File dialog. 
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You can select or deselect all via the top two check circles or use the check boxes to select or deselect 
single options. These default settings will show up the next time you export to a file. They also 
determine what will be express exported. 

Default: Pressure Unit 
The unit of blood 
pressure used in 
all the reports, 
analyses, and 
displays can be 
changed in the 
Default main 
menu between 
mmHg (millimeters of mercury) or kPa (kilopascals). The mmHg pressure unit is common in North 
America, while kPa is the metric system equivalent used in China and other countries where the metric 
system is preferred. You can toggle the DP5000A device itself between displaying pressures in mmHg 
or kPa, but the DP5000A device does not need to be set in the same pressure unit you select via  the 
DynaPulse software program when transferring data.

Default: Histogram Bin Size 

The Histogram Bin 
Size selects the bin 
size number for 
histograms in the Day 
Night Statistic 
analyses. A histogram 
is a counting chart 
that displays the 
number of times a 
measurement falls 
within a certain blood pressure or heart rate range. The results are shown as a frequency (the count) vs. 
bin size (the measurement range) graph. The bin size in the DynaPulse histograms can range from as 
small as 1 increment up to as large as 5 increment values. If the pressure unit is chosen as kPa instead of 
mmHg the bin size must be 1 kPa.

Default: Institution 

The Institution Information dialog opens automatically the first time the DynaPulse program is loaded. 
You can also select Institution from the Default menu to open the dialog. The information you enter here 
will become the default institution information that can be imported for each patient to save input time. 
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The institution data can be changed at any time for separate patients in each individual's personal 
information screen. 

Chart Styles
See Plot Style - Line Plot and Area Plot on page 17.

Statistical Analysis Graphic Displays
  The Analysis menu provides a 
variety of charts and histograms that 
make the measurements easier to 
understand. You can use them to 
compare the analysis data from 
before and after medication. The 
following graphic options are 
available:

Menu Item Content Format Options

Raw Data Chart of all data 
over time

Linear only

Validated 
Data

Chart showing 
only unmasked 
measurements 

Linear only

Hourly 
Average

Hourly-averaged 
data

Linear or time slice

Bi-hourly 
Average

Data averaged 
for every two-
hour period

Linear or time slice

Day Night 
Statistic

Histograms of 
day and night 
values

Displays for systolic, 
diastolic, MAP, heart 
rate, or all of the above

For all Charts and Histograms

1. By default, systolic values are shown in red, MAP values in yellow, diastolic values in blue and 
heart rate values in green. Nighttime is shown in gray.

2. The average value (Ave) is the arithmetic average of the analyzed measurements.  

3. The standard deviation (SD) is a range surrounding the average value within which 67% of the 
measurements will fall.  The larger the SD, the wider the range.  
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Analysis: Raw Data vs. Validated Data
Only linear charts are available for the Raw and Validated data displays. The Raw Data display shows 
all of the blood pressure data, including both masked measurements and validated, or unmasked data. 
Validated Data excludes the masked and erroneous blood pressure measurements. 

The left part of the chart displays blood pressure (BP) and a heart rate (HR) charts. The BP thresholds 
are displayed in the upper banner of the BP chart.  The maxima, minima, average and SD (standard 
deviation) heart rates are displayed in the upper banner of the HR chart for both day and night periods. 

Charts can be displayed in either area plot style, with values below threshold shaded in; or line plot 
style, with thresholds shown by dotted line and no shading (see Chart Styles on page 29). 

The right part of the chart contains three groups of pie charts analyzing systolic, MAP and diastolic 
values separately in day and nighttime. Pie charts are drawn as percentage breakdowns of normal, over-
threshold, and erroneous data. The upper banners show the percentages of totals, daytime and nighttime 
values greater than threshold. 

Analysis: Hourly or Bi-hourly Average 

The Hourly and Bi-hourly analysis charts have both Linear and Time Slice formats. 

Linear
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Time-sliced

Linear charts plot data over time in x-y plots with pie charts also shown to the right. Time-sliced charts 
display averaged data in pie charts with time periods of one or two hours indicated by slices.

The Hourly Average chart calculates and displays the average of validated data for each one-hour 
period. The Bi-hourly Average analysis uses two-hour time periods. Linear charts can be displayed in 
either area plot style, with values below threshold shaded in; or line plot style, with thresholds shown by 
dotted line and no shading. 

BP: Blood pressure thresholds are displayed in the upper banner of the BP chart. Set the BP thresholds 
beforehand, as described above. They are used to flag instances of hypertension or other blood pressure 
events. 

HR: Day and night maxima, minima, average and standard deviation values of heart rate are displayed 
in the upper banner of the HR chart. The right part of the chart contains three groups of pie charts 
analyzing systolic, MAP and diastolic values separately in day and nighttime. Pie charts are drawn as 
percentage breakdowns of normal, over-threshold, and erroneous data. The upper banners show the 
percentages of totals, daytime and nighttime values greater than threshold.

Analysis: Day Night Day/Night Histogram

The Day Night Statistic option allows you to select Systolic, Diastolic, MAP, Heart Rate histograms or 
All of them for column chart analysis. If you select all, as we have below, and you want to see just one, 
double click on the one part of the chart and it will enlarge.

A histogram will tally the frequency of day and night pressure readings that exceed your specified 
threshold levels. 

In the upper banners of each histogram, you can see mean, maximum, minimum, and standard deviation 
(SD) values. By default, data are grouped in five-value intervals. For example, 60 to 64 inclusive is 



32    

grouped in 60, and 115 to 119 inclusive are grouped in 115. To change the interval values, select 
Histogram Bin Size on the Default menu. 

Direct Print 

Use the express print toolbar button  to export all default data files and print all of the default graphs 
and reports.

The Direct Print command on the 
Analysis menu works like the print 
function on the File menu and 
toolbar, except that it displays the 
Print Graphs dialog, which allows 
you to print selected graphs for a 
patient without displaying them. 

The selections are your previous default print settings, but you may change them here for this printing. 
Your default selections remain unchanged. You can select all graphs or any combination of the listed 
options. Click in the check box to toggle the option. Click on the Print button to start the print. 

Reports

You can use the Report menu 
options when you have selected 
a patient on the patient list. 

For printing options, see 
Printing on page 23.

The following DynaPulse 
5000A reports are available:

Menu Item Content

Raw Data Chart of all data over time

Validated Data 
Analysis

Chart showing only unmasked 
measurements 
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Hourly Average 
Analysis

Hourly-averaged data

Bi-hourly Average 
Analysis

Data averaged for every two-hour 
period

Day Night Statistic Day and night values for systolic, 
diastolic, MAP, and heart rate

Personal Info Information gathered via the 
Personal Info dialog

Report: Day-Night Analysis 

The Day Night Statistic report displays error, masked, and validated data with totals. It also reports 
averages and standard deviations (STD) of the blood pressure and heart rate measurements during 
daytime, nighttime, and for total

time, as well as listing the maxima and minima of each value during each time period, listing the time 
each measurement was taken.

Report: Raw Data Analysis
Raw Data Analysis reports the percentage breakdown of all raw data. Systolic, diastolic, and MAP 
pressures are tallied into normal, over-threshold, and invalid (masked and erroneous) measurements 
according to day, night, and total time. The percentage breakdown can be seen in graphical form in the 
pie charts of the linear raw data analysis chart.
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Report: Validated Data Analysis
The Validated Data Analysis report is similar to the raw data report, except that invalid measurements 
are not reported. Normal and over-threshold systolic, diastolic, and MAP values are shown by day, 
night, and total time period. A graphical display is also available via the Analysis menu.
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Report: Hourly Average Analysis

The Hourly Average Analysis report differs from the raw data report in that the data is first averaged per 
hour and then analyzed into normal, over-threshold, and masked and erroneous categories according to 
day, night, and total time. 

Report: Bi-Hourly Average Analysis
The Bi-hourly Average Analysis report is similar to the hourly average analysis, except that the data is 
averaged for every two hours rather than one. 

Report: Personal Info 
A detailed two-column personal information report can be printed out to keep in file for each patient. 
You can fill in basic information about the selected patient in the Personal Information screen. 
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Direct Print 

Use   (the express 
print toolbar button) to 
export all of the default 
data files and print all 
of the default graphs 
and reports. Direct 
Print on the Report 
menu works like Direct 
Print on the Analysis 
menu, except that the 
print dialog allows you 
to print selected reports instead of graphs.
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Export Results to a File 
To export blood pressure data into a text 
(ASCII) file or similar file for use outside of 
the DynaPulse program, choose Select from  
the Export menu, which appears only when you are viewing 
a data display. This will 
bring up the ASCII 
Output to File dialog. 
The selections will be 
your default settings, 
but you may change it 
for just this time and 
output your new 
selections. Your default 
selections will remain 
unchanged.

After exporting, a separate dialog box will appear listing the names of the files outputted. These files can 
be found in the Export subdirectory: for example, if you installed DynaPulse software in the default 
C:\Dp5win directory, the ASCII files can be found in C:\Dp5win\Export.Text files can be read with any 
text editor program such as Windows Notepad. 

THE TOOL WINDOW

The Tools menu appears 
whenever a patient has been 
selected on the Patient List. 
It is a shortcut menu for all 
the Direct Print options
available in the Analysis and Report menus. As with Direct Print, your default printing selections will 
remain unchanged after changing printing selections through the Tools functions. 
Direct Print/Export Defaults: This option allows you to print all analysis graphs and reports and to 
export data results to ASCII files using to your default settings. The Express Print toolbar button is the 

shortcut button for this menu item. 

Direct Print Graphs: This menu item is the same as the Direct Print in the Analysis menu: it will print 
all default analysis graphs. You may select new graphs to print for just this time. 

Direct Print Reports: This menu item is the same as the Direct Print in the Report menu: it will print all 
default analysis reports. The selected reports are your previous default settings, but again you may 
change them just for this time and print your new selections. 
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IV. OPERATION REFERENCES

MENUS FOR THE DYNAPULSE 5000A

The menu bars and tool bars change as you move from screen to screen.  There are at least five 
variations.  The two shown below show all of the 13 menu options listed on the following pages.

Menu and toolbar when Patient List is active

Menu and toolbar when Trend List is active

Open  Patient Lists

Print  active report window

See the document as it will print

Set the default printer and active 
printing

List of open files

Exit -Exits the DynaPulse program

Set the data used in reports

Set what reports to print

Set what data are exported in ASCII

Choose mm Hg or kPa

MmHg/BMP

Edit the institution information

Add new patient to list

Edit existing patient information in list

Permanently remove a patient’s record

Search for patient name or ID

Show next match to name search

Select the highlighted patient name
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Toggle display mode to show dotted line 
only or color filled 

Toggle display mode to show or hide MAP

Toggle display mode to show or hide label

Prepare monitor for ambulatory collection

Disable monitor from ambulatory collection

Transfer collected data from monitor to PC

Clear the memory of the monitor

Patient List display

Display Patient Trend List

View the Personal Info dialog

  Turns Toolbar off/on 

Turns Status Bar off/on

During graphic display

Display Trend Graph

Display Patient Trend List

Display Measurement List

View the Personal Info dialog

Turns Toolbar off/on 

Turns Status Bar off/on 

Print all reports selected in Default

Set analysis parameters

Display analysis charts using the 
display method indicated

Print all selected or default graphs and 
reports and make default exports

Display tabular column reports

Personal Information Report
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Display com port settings

Automatically configure the com port

Close the Patient List

Close a Patient’s active windows

Close all Patient’s active windows 

Cascade all open windows

Tile stack all open windows

Arrange open dialogs as icons on 
the bottom of the page

Displays what windows are open

Export data in ASCII format

Print all reports and exports data

Print all graphs

Print all reports

Index of on-line Help topics

Information about the software
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V. TROUBLESHOOTING 

ERROR MESSAGES DURING COMMUNICATION:

“No Data in the unit”: Indicates that the monitor-PC interface is working, but there are no data in the 
monitor to transfer.

“Patient ID Mismatch”: Indicates that the monitor-PC interface is working, but the ID selected for data 
transfer does not match the ID chosen when the monitor was enabled for ambulatory operations.

“Communication Error”: Indicates a problem with the interface. Possible causes:

a. Switched off or inactive DP5000A monitor: Use the side switch to activate monitor, and push the 
on/off button on the face of the monitor. Then wait for the monitor to cycle to the “ready 
measurement” mode.

b. Insufficient DP5000A monitor power: Check batteries, and replace if necessary.

c. Faulty USB cable: Contact Pulse Metric Technical Support or its authorized distributor for 
replacement information.

When a “communication error” message appears, try to repeat the desired function before assuming 
there is a problem. The DP5000A has a “sleep” mode that helps to save battery life and just does not 
“wake-up” fast enough for some processors.
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VI. APPENDICES

COM PORT CONFIGURATION:  WINDOWS 98/ME/2000/NT/XP

For technical problems with the COM port configuration, call Technical Support at (760) 842-8224, or 
E-mail teksupport@dynapulse.com.
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CHECKING CALIBRATION

To check the calibration of the DynaPulse 5000A unit in reference to a standard sphygmomanometer, 
you will need to connect a sphygmomanometer (recommend vertical mercury type) T - connector with 
the DP5000A and the cuff. Wrap the cuff loosely around a bottle that approximates an arm size (non-
crushable). 

Before you continue, be aware that you should not open the DP5000A to adjust the calibration of the 
unit or you will void all warranty.  Also, only perform this procedure if you think the DP5000A is off by 
more than +/- 3mmHg.

Steps to check calibration:

1. Once sphygmomanometer is connected in line with the DP5000A and cuff, run the DynaPulse 
software.  

2. Go to Measure and set the high range to 220mmHg and leave the low range at default of 50mmHg.

3. Set the top of the speed knob on the DP5000A to S.  This is the slowest bleed rate possible.

4. Go to Measure and Start.  Select three measurement points such as 200, 160, 80 mmHg to compare 
the sphygmomanometer with what you see on screen.   

5. Once the measurement begins, record the values you get from the sphygmomanometer and the 
computer screen as the air slowly leaks from the system.   

If there is greater than +/- 3 mmHg difference between the values, contact Pulse Metric to schedule a 
calibration of your DP5000A.  Again, do not try to calibrate the DP5000A yourself.

DYNAPULSE USB DRIVERS

Instruction for installing the two DynaPulse USB drivers needed for operation of the DynaPulse 
Ambulatory Blood Pressure Monitor.  

NOTE: Be sure you install the drivers before you connect your DynaPulse Ambulatory Blood Pressure 
Monitor to your computer.

1. Insert the 'USB drivers' CD into your CD Rom Drive.

2. Next, connect the DynaPulse Ambulatory Blood Pressure Monitor to your computer via the provided 
USB cable. Please NOTE: the unit must be powered on when making the connection.

3. This will start the 'Found New Hardware Wizard'. Click 'Next >'. Keep the option 'Search for a 
suitable driver for my device (recommended) selected. Click 'Next >'.

4. Make sure that the 'Specify Location' option is checked under the 'Optional search locations' then 
click 'Next >'. When the next window opens, click on the 'Browse' button and navigate to the folder 
contents found on the CD, which contains the driver belonging to your computer's operating system. If 
you are using Windows 2000 or Windows XP, you will need to select the folder titled 'Win2K_XP'. If 
you are using Windows 98 Second Edition, you will need to select the folder titled 'Win98SE'. When the 
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appropriate folder is displayed in the 'Look in:' field, click 'Open'. The 'Locate File' window will close. 
Click 'OK' to close the remaining window. If successful, you should be prompted with the 'Driver Files 
Search Results' window indicating that the wizard has found a driver to the device. Click the 'Next >' 
button

5. Finally, you should be presented with a window reading 'Completing the Upgrade Device Driver 
Wizard'. Click 'Finish'.

6. When this first file installation is complete, another prompt will be given indicating 'New Hardware 
Found', 'CP210x USB to UART Bridge Controller'. File settings from the previous file installation will 
carry over and the 'Next >' button needs to be clicked until the final installation screen is displayed, 
indicating completion of the secondary driver file.

7. The driver files needed to use your DynaPulse Ambulatory Blood Pressure  Monitor are now loaded 
on your computer.

If the 'Found New Hardware Wizard' does not start when the DynaPulse Ambulatory Monitor is 
first plugged in to the USB port follow these steps.

1.From 'Start' open 'Control Panel', then open 'System' or for Windows XP operating systems, open 
'Performance and Maintenance' then 'System'. Choose the 'Hardware' tab and then click the 'Device 
Manager' button. 

2. Select the entry 'Other devices', and see if below this heading a listing of 'CP2102 USB to UART 
Bridge Controller' can be found. If it is, highlight and right click to choose 'Properties'. Then select the 
'Driver' tab and choose the 'Update Driver...' button. This will bring up the 'Upgrade Device Driver 
Wizard'. Choose 'Next >'. Keep the option 'Search for a suitable driver for my device (recommended) 
selected. Click 'Next >'.

3. Make sure that the 'Specify Location' option is checked under the 'Optional search locations' then 
click 'Next >'. When the next window opens, click on the 'Browse' button and navigate to the folder 
contents found on the CD, which contains the driver belonging to your computer's operating system. If 
you are using Windows 2000 or Windows XP, you will need to select the folder titled 'Win2K_XP'. If 
you are using Windows 98 Second Edition, you will need to select the folder titled 'Win98SE'. When the 
appropriate folder is displayed in the 'Look in:' field, click 'Open'. The 'Locate File' window will close. 
Click 'OK' to close the remaining window. If successful, you should be prompted with the 'Driver Files 
Search Results' window indicating that the wizard has found a driver for the device. Click the 'Next >' 
button

4. Finally, a window should be displayed reading, 'Completing the Upgrade Device Driver Wizard'. 
Click 'Finish'. Close the remaining 'Properties' window.

5. The driver files needed to use your DynaPulse Ambulatory Blood Pressure  Monitor are now loaded 
onto your computer.

If the DynaPulse software is unable to detect the DP5000A Ambulatory Blood Pressure Monitor, 
proceed with the following instruction.
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Check the Port assignment of the 'CP2102 USB to UART Bridge Controller'.

1. Check to make sure that there is a new entry under the 'Ports (Com & LPT)' folder found under the 
'System' folder in 'Control Panel'. It should read, 'CP210x USB to UART Bridge Controller (Com X)'.

2. You will need to ensure that the COM Port number (X) assigned to the DynaPulse Ambulatory Blood 
Pressure Monitor is set to a value between 1 and 4. To change this value, right click on the listing 
'CP210x USB to UART Bridge Controller (Com X)'  found below the sub-heading Ports (COM & LPT) 
and select 'Properties'. Select the 'Port Settings' tab. Then select the 'Advanced...' button. In the 'COM 
Port Number:' select any available COM number that is between 1 and 4. Click 'OK' for all open 
windows in order to complete the settings change. Please NOTE: If one through four is not available, 
you will need to remove one of the existing devices in order to free up the COM port for the DynaPulse 
Ambulatory Blood Pressure Monitor.

3. Finally, close all remaining windows pertaining to the control panel and start the DynaPulse 5000A 
Ambulatory Blood Pressure Monitor software.

4. Click the 'ComCheck' option found under 'Port' option of the taskbar. Please NOTE: the unit must be 
powered on when running 'ComCheck'. If the DynaPulse 5000A Ambulatory Blood Pressure Monitor is 
found, the unit can now be used with the connected computer.

WARRANTY INFORMATION

Pulse Metric, Inc. warrants that the DynaPulse 5000A system unit will be free from defects in workmanship and 
materials for a period of one year from the date of purchase. This one-year warranty extends only to the original 
purchaser.  Pulse Metric, Inc. will repair or replace at its option any defective parts or product when shipped to the 
initial purchaser. This limited warranty DOES NOT cover damages or losses due to improper environment, 
temperature extremes, or other misuse or negligence, such as adjustment or repair by personnel not authorized by 
Pulse Metric, Inc., improper installation, failure to follow the installation instructions, or shipment to or from the 
distributor or customer.

Pulse Metric, Inc.’s liability shall not exceed the price of the defective product itself, which is the basis of the 
claim. Tampering with the unit voids this warranty.  In no event shall Pulse Metric, Inc. be liable for any loss of 
profits, loss of use of facilities, loss of other equipment, or any incidental or consequential damages, even if Pulse 
Metric, Inc. has been advised of the possibility of such damages. Some states do not allow the exclusion or 
limitation of incidental or consequential damages, or allow limitations on how long an implied warranty lasts, so 
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the above limitations or exclusion may not apply to you.  This warranty gives you specific legal rights, and you 
may have other rights, which vary from state to state.

Technical Support and Service:

Phone: (760) 842-8224
Fax: (760) 758-9425
E-mail: teksupport@dynapulse.com

Technical support representatives are available between 10:00 a.m. to 3:00 p.m. Pacific Time, Monday through 
Friday.

All products returned to Pulse Metric, Inc. must be accompanied by a Return Material Authorization (RMA) 
Number and the original (or a copy) of the dated sales slip as proof of warranty.  An RMA Number can be 
obtained by calling Technical Support at 
(760) 842-8224.  Packages sent without an RMA Number marked on the outside of the shipping container 
may be refused.  Please also include a letter with contact person’s name, address, telephone number, return 
address and brief description of the problem(s).
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SOFTWARE LICENSING AGREEMENT

This is a legal Agreement between you (the end user, being either an individual, or legal entity such as a 
corporation), and Pulse Metric, Inc. (PMI).  By clicking the "Accept" button that appears after you see 
this Agreement when you install your software, you are agreeing to be bound by the terms of this 
software agreement.  If you do not agree to the terms of this Agreement, immediately remove all traces 
of the PMI software product from your computer and disk archives and promptly return the disk package 
and the accompanying items (manuals, DynaPulse unit, and all accessories) to the place you obtained 
them for a full refund.

Part I - Grant of License

PMI grants you the right to use one copy of the enclosed DynaPulse software program (SOFTWARE) 
on a single computer at a time.  You may not rent or lease the SOFTWARE, but you may transfer the 
SOFTWARE and accompanying written material provided you do not retain copies and the recipient 
agrees to the term of this Agreement.  You may not reverse engineer, recompile, or disassemble the 
SOFTWARE.  The agreement is effective from the day you open the sealed package until terminated.  
You may terminate this Agreement by returning to PMI the original disks and any backup copies.  If you 
breach this Agreement, PMI can terminate this license upon written notification to you.

Part II - Copyright

The SOFTWARE is owned by PMI and is protected by United States copyright laws and international 
treaty provisions.  Therefore, you must treat the SOFTWARE like any other copyrighted material except 
that you may either:

(a) Make one copy of the SOFTWARE solely for backup or archival purposes 

-or-

(b) Transfer the SOFTWARE to a single hard disk provided you keep the original solely for backup 
purposes.  You may not copy the written material accompanying the SOFTWARE.

Part III - Controlling Law

This Agreement shall be governed by and construed in accordance with the laws of the State of 
California.
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COMPANY INFORMATION 

Pulse Metric, Inc. (PMI) was incorporated in 1990 to develop and market instrumentation and software for the diagnosis and 
management   
of hypertension, and to develop technology and instrumentation for arterial pressure and waveform analysis. 

PMI’s non-invasive blood pressure waveform technology, Pulse Dynamics, is patented in the United States and worldwide. 
Several different DynaPulse products are available including systems for clinical hypertension management, home blood 
pressure monitoring, and ambulatory monitoring. 

If you have any questions or require additional information, you can reach us between 9:00AM and 5:00PM Pacific Time.

Address: Pulse Metric, Inc.
2100 Hawley Drive
Vista, CA 92084 U.S.A.

Order Lines: (760) 842-8278
Internet e-mail sales@dynapulse.com

Facsimile: (760) 758-9425

Web Site: http://www.dynapulse.com

Technical Support:
Voice: (760) 842-8224
E-Mail: teksupport@dynapulse.com


